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About this Release 
This document describes Geospatial Licensing 2020. Geospatial Licensing delivers the necessary components 
for users to take advantage of licensing functionality. This document is only an introduction and does not 
provide all the details about the product’s capabilities.  The naming conventions of the licensing product and its 
subcomponents have been updated for more accuracy. Please use the key in the issues resolved section for 
clarity. See the Geospatial Licensing document delivered with your product or online Help for more information. 

 

New Platforms 
Geospatial Licensing 2020 has been tested and verified as supported on Windows 10 Pro (64-bit) operating 
system. 

System Requirements 
  

Computer/ Processor  • 64-bit: Intel 64 (EM64T), AMD 64, or equivalent (recommended) 

 (Multi-core processors recommended) 

Memory (RAM)  • 2 GB minimum 

Disk Space  • 275 MB for software installation 

Operating Systems • Windows® 7 SP1 or higher, Professional and Ultimate (64-bit)  

• Windows® 8 (Standard), Professional and Enterprise (64-bit)  

• Windows® 8.1 (Standard), Professional and Enterprise (64-bit)  

• Windows 10 Pro (64-bit) 

• Windows Server® 2008 R2 SP1 (64-bit)  

• Windows Server 2012 R2 (64-bit)   

• Windows Server 2016 (64-bit) 

• Windows Server 2019 (64-bit) 

Software  • .NET Framework 4.7.2  

• XMLLite (included with most Windows operating systems) 

• Adobe® Reader® 7 or higher  

• TLS 1.2 (included with most Windows operating systems) 



  

 

Peripherals  All software installations require:  

• One Windows-compatible mouse with scroll wheel or equivalent input device  

• Printing requires Windows-supported hardcopy devices  

• Ethernet card, or   

• One USB port for hardware key   

 

Naming Convention Key 2020 Licensing  
Previous Naming Convention mentioned in Issues Resolved Current Naming Convention 

CLC           Geospatial Licensing (product) 

Geospatial License Administration (Administrator) 

Geospatial License Administrator 

License Administrator   

Licensing Administrator   

Geospatial Licensing Administrator 2018 

Hexagon Geospatial License Administrator 

License Admin 

CLC Licensing Administrator 

Geospatial Licensing Administration 

N/A Geospatial Licensing Borrowing 

 
Issues Resolved 
 

Issue ID Summary Description / How to Reproduce 

LI-81 

 

Siebel ID: 

1-A6FTX8 

 

License Administrator shows 
incorrect Expiration Date 

The Geospatial License Administration (Administrator) utility displays 
permanent licenses as if they have expired. Specifically, on the summary 
page listing all licenses the Expiration column shows the date "01-Jan-2000" 
and when a specific license is selected the details page shows the 
expiration date of 1/1/2000 12:00:00 AM. Since the 1/1/2000 is in the past, 
customers are concerned and believe that their license has expired when in 
fact it is permanent. A different means of indication for a permanent license 
should be employed perhaps using a date that is in distant future (e.g. 
12/31/2099). 



  

 

Salesforce: 

00016693 

00043312 

00038596 

00044132 

00045633 

LI-133 License Admin - Help>About should 
display the version number of 
Geospatial Licensing Administrator 
2018 

Currently, Help > About dialog does not display the version number in the 
Geospatial Licensing Administrator 2018 interface. Users should be able to 
select a Help>About to look up what version number of Geospatial 
Licensing Administrator 2018 is installed. 

LI-175 

 

Salesforce: 

00045168 

00040821 

00041324 

License Administrator displays 
incorrect expiration date 

If an older license still exists on the machine the user has imported a new 
license on, then the expiration date will reflect the older license’s expiration 
date when reviewing the licenses hosted on the license server in Hexagon 
Geospatial License Administrator When there are multiple licenses present 
on one machine, the newest license expiration date should be displayed.   

LI-178 Upgrade CLC to Flexera's FNP 
11.16.2.1 

Upgrade CLC to Flexera's FNP 11.16.2.1 

LI-182 

 

Upgrade the CLC Licensing 
Administrator Setup for 2019 release 

The initial internal release of the CLC contains a Licensing Administrator 
that references  2018 instead of the 2019 release. . 

Also - One Hexagon branding is not reflected, i required. 

LI-184 

 

CLC utilities do not work Utilities delivered with CLC 16.6.2+build.29 do not work.  For example, 
appactutil.exe will not list valid node locked licenses on the local machine. 

LI-189 

 

License Administrator 2019 crashes 
when providing a specific license 
server. 

1. Launch Geospatial License Administrator 

2. Add concurrent License Source from View tab 

3. Provide the server name as in-hgd-licsrv01 and click Ok 

4. Observe Geospatial License Administrator crashing 

LI-190 

 

Licensing Administrator should 
display the Licensing installer 
version 

Currently, Licensing Administrator displays its own version prominently on 
the menu bar in its main window. To avoid customer confusion, update to 
display the installer version in this location instead. 



  

 

LI-191 Latest licensing installer forces an 
immediate reboot 

When installing Build 1035 (after uninstalling 1016) 

A warning stating that the prerequisite Geospatial Licensing install was 
required (16.5.0.21 would have already been present). 

Then, without warning, the installation of Geospatial Licensing forced a 
reboot of the machine. 

The reboot was extremely problematic considering it was running via VPN. 

A reboot should not be required when installing new licenses, and if so 
should say "reboot required to complete the installation" to allow the user to 
reboot when appropriate. 

 

 

About Hexagon 
Hexagon is a global leader in sensor, software and autonomous solutions. We are putting data to work to boost 
efficiency, productivity, and quality across industrial, manufacturing, infrastructure, safety, and mobility 
applications.  

Our technologies are shaping urban and production ecosystems to become increasingly connected and 
autonomous — ensuring a scalable, sustainable future.  

Hexagon’s Geospatial division creates solutions that deliver a 5D smart digital reality with insight into what was, 

what is, what could be, what should be, and ultimately, what will be.  

Hexagon (Nasdaq Stockholm: HEXA B) has approximately 20,000 employees in 50 countries and net sales of 

approximately 4.3bn USD. Learn more at hexagon.com and follow us @HexagonAB. 

 

Copyright  
© 2019 Hexagon AB and/or its affiliates. All Rights Reserved. Hexagon has registered trademarks in many 
countries throughout the world. Visit the Trademarks Page for information about the countries in which the 
trademarks are registered. 

Product Documentation Terms of Use 

PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S 
DOCUMENTATION ("DOCUMENT"). USE OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS 
AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE TERMS HEREOF ("TERMS"), 
DO NOT USE THIS DOCUMENT. 

Use Of This Document 

All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, 
trademark, and other laws. Subject to the terms of this Agreement, Hexagon Geospatial (a Division of 
Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby authorize you to reproduce this 
Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to 
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any 

https://www.hexagongeospatial.com/
https://hexagon.com/
https://twitter.com/hexagonab
https://www.hexagongeospatial.com/legal/trademarks


  

 

way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or commercial 
purpose, except as specifically authorized in a separate agreement with Hexagon Geospatial.  

The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of 
rights of a third party. Except as expressly provided above, nothing contained herein shall be construed as 
conferring by implication, estoppel or otherwise any license or right under any copyright, patent or trademark of 
Hexagon Geospatial or Intergraph or any third party. 

If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon 
termination, you will immediately destroy any downloaded or printed Materials in your possession or control. 

Disclaimers 

ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, 
that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials 
available are free of viruses or other harmful components. 

Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial 
may make changes to this Document at any time without notice. 

Limitation Of Liability 

IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA 
OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR 
TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT. 

Indemnification 

You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and 
agents from and against any and all claims, liabilities, damages, losses or expense, including reasonable 
attorneys fees and costs, arising out of or in any way connected with your access to or use of this Document. 

Use Of Software 

Use of software described in this Document is subject to the terms of the end user license agreement that 
accompanies the software, if any. You may not download or install any software that is accompanied by or 
includes an end user license agreement unless you have read and accepted the terms of such license 
agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors. 

Links To Third Party Websites 

This Document may provide links to third party websites for your convenience and information. Third party 
websites will be governed by their own terms and conditions. Hexagon Geospatial does not endorse 
companies or products to which it links. 

Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no 
control. Hexagon Geospatial shall not have any liability resulting from your use of the third party website. Any 
link you make to or from the third party website will be at your own risk and any information you share with the 
third party website will be subject to the terms of the third party website, including those relating to 
confidentiality, data privacy, and security. 

Trademarks 



  

 

The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon 
Geospatial, Intergraph or other third parties. Users are not permitted to use Marks without the prior written 
consent of Hexagon Geospatial, Intergraph or the third party that owns the Mark. "Intergraph" is a registered 
trademark of Intergraph Corporation in the United States and in other countries. Other brands and product 
names are trademarks of their respective owners. 

Find additional trademark information. 

Procedure For Making Claims Of Copyright Infringement 

Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following 
address: Intergraph Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 
35824. 

US Government Restricted Right 

Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. 
Government is subject to restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or 
successor provisions thereto. Use of Materials by the Government constitutes acknowledgement of Hexagon 
Geospatial or Intergraph’s proprietary rights therein. 

International Use 

You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial 
makes no representation that Materials are appropriate or available for use in every country, and access to 
them from territories where their content is illegal is prohibited. 

Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain 
references or cross references to Hexagon Geospatial products, programs and services that are not 
announced in your country. These references do not imply that Hexagon Geospatial intends to announce such 
products, programs or services in your country. 

The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to 
comply strictly with all such laws and regulations. In addition, you represent and warrant that you are not a 
national of, or otherwise located within, a country subject to U.S. economic sanctions (including without 
limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from receiving 
or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon 
Geospatial makes no representation that the Materials are appropriate or available for use in every country, 
and access to them from territories where their content is illegal is prohibited. All rights to use the Materials are 
granted on condition that such rights are forfeited if you fail to comply with the terms of this agreement. 

Revisions 

Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly 
reviewing these Terms. Your continued use of this Document after the effective date of such changes 
constitutes your acceptance of and agreement to such changes. 

Applicable Law 

This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of 
the State of Alabama will govern these Terms, without giving effect to any principles of conflicts of law. You 
hereby irrevocably and unconditionally consent to submit to the exclusive jurisdiction of the United States 
District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for Madison 
County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to 
commence any litigation relating thereto except in such courts), waive any objection to the laying of venue of 
any such litigation in such Courts and agree not to plead or claim in any such Courts that such litigation 
brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions or 



  

 

limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the 
maximum extent allowed by applicable law. 

Questions 

Contact us with any questions regarding these Terms. 

https://www.hexagongeospatial.com/about-us/our-company/contact-us
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